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1. Executive Summary 
This report provides details of a new hyperspectral exploitation tool for developing 

trafficability special maps from hyperspectral imagery.   This new tool, known as the 
NRL Hyperspectral Imagery Trafficability Tool (HITT), is packaged as a plug-in to the 
commercial software package ENVI/IDL.   HITT is one of several tools being developed 
and validated by NRL to support coastal characterization from spectral region imagery.  
This report provides a step-by-step description of the operation of HITT, working 
through specific examples that begin with a hyperspectral data cube and end with a 
special map of estimated trafficability in a coastal region.  The basis of this new 
product is a set of spectral-geotechnical libraries and models developed during remote 
sensing and calibration/validation campaigns conducted by NRL and collaborating 
institutions in four different coastal types. 

2. Introduction 
“Trafficability” is defined as the ability to move people and/or equipment through a 

region (Bachmann, Nichols, et al, 2009).  Developing methods to estimate trafficability 
in an automated manner and map this property of sand, soil, or sediment over a large 
region from remote sensing replaces manually intensive and sparse information 
obtainable on the ground by engineers at point locations.   This report describes a new 
NRL software tool developed by the authors, the Hyperspectral Imagery Trafficability 
Tool (HITT), to provide one possible solution to this important problem.  Our approach 
utilizes hyperspectral imaging and spectral-geotechnical libraries and models to 
exploit this imagery and provide a robust, wide-area solution, which is a map of 
estimated soil, sand, or sediment bearing strength.   

Spectral and geotechnical libraries collected by the Naval Research Laboratory 
(NRL) Code 7232 during the Virginia Coast Reserve 2007 (VCR’07), Hawaii 
Hyperspectral Airborne Remote Environmental Sensing 2009 (HI-HARES’09), 
TALISMAN SABER’09, and Mariana Island Hyperspectral Airborne Remote 
Environmental Sensing 2010 (MI-HARES’10) experiments are described in four data 
reports (Bachmann, Nichols  et al, 2012d, 2012e; Bachmann, Fusina, et al, 2012b; 
Bachmann, Fry, et al, 2012a)  and are the basis of this initial version of HITT (HITT 
1.0).  Our methodology which uses a look-up table (LUT) approach for retrieving an 
estimate of dynamic deflection modulus (Zorn, 2005), i.e. bearing strength in units of 
pressure, appears in (Bachmann, Nichols et al, 2010f, 2009, 2008a).  The spectral-
geotechnical libraries that support retrieval of these products were collected during 
these four remote sensing and cal/val campaigns.  Although specific relationships 
exist between hyperspectral remote sensing and primary physical variables such as 
surface moisture,  and grain size, there are some limits to our existing models, for 
example, for retrieval of grain size, which do not apply under all conditions 
(Bachmann, Nichols et al, 2010f).  Further improvement to models for grain size 
_______________
Manuscript approved February 28, 2011. 
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retrieval to accommodate a wider variety of conditions is still needed, and therefore the 
LUT method, which involves building a table of known reflectance and geotechnical 
data measured at the same location, serves as an acceptable alternative (Figure 1), for 
now, to obtain a usable estimate of bearing strength (dynamic deflection modulus) 
from hyperspectral remote sensing.  

 

Figure 1. Trafficability inferred from the surface hyperspectral signature can ultimately be 
estimated in two ways: via retrieval of intermediate geotechnical variables which are then used in 
a model to predict trafficability, or via a direct relationship between the observed spectral 
response and trafficability, such as the LUT approach described in this report and in (Bachmann, 
Nichols et al, 2010f, 2009, 2008a). 

We fully acknowledge the limitations of remote sensing from hyperspectral remote 
sensing for this application, noting that hyperspectral remote sensing looks only at the 
surface and does not provide information about sub-surface layers.  At the time of this 
report, we are embarking on an effort to examine a multi-sensor approach to the 
problem which will, at least in part, provide information from below the surface.  The 
scope of this report documents only our approach to using the LUT method described 
above for hyperspectral imagery and employing our field measurements of in situ 
spectral reflectance and corresponding geotechnical properties.  The package of our 
software, libraries, and look-up tables for this application is called Hyperspectral 
Imagery Trafficability Tool (HITT), which is detailed in this report. 

Soil 
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3. Overview of Methods 
In our NRL HITT approach, all of the steps required to develop a trafficability map 

from hyperspectral imagery are presently executed within the commercial ENVI/IDL 
package software package using add-ons that we have developed.  To that end, we 
have written a series of IDL routines that can be run within the ENVI/IDL 
environment.  These routines have relatively simple graphical user interface (GUI) 
components, which query the user to provide the necessary inputs and ultimately 
render and save the resulting products automatically.  Collectively this set of routines 
comprises the HITT tool.  This report explains the operation of each HITT routine and 
the workflow for operating these HITT routines to start from hyperspectral imagery 
and ultimately produce a trafficability map from the associated spectral-geotechnical 
libraries. 

In this report, our operating assumption is that the end-user has been provided 
with a hyperspectral calibrated radiance file.  If a reflectance file has not also been 
provided to the end-user, then the end-user must atmospherically correct the data to 
obtain a reflectance data cube, as NRL HITT requires that the input hyperspectral 
imagery be in the form of a reflectance data cube.  NRL Code 7232 provides the Tafkaa 
atmospheric correction software to allow end-users to produce an atmospherically 
corrected reflectance data cube.  Documentation for Tafkaa can be found in (Montes, 
Gao, and Davis, 2004). Alternatively, the end-user can elect to perform data 
atmospheric correction using one of the available atmospheric correction routines 
found in ENVI such as FLAASH (Adler-Golden, et al) or QUAC (Bernstein et al, 2005) 
or some other commercially available alternative.  A reflectance cube must be obtained 
by one of these methods in order to be able to compare the imagery reflectance data 
with our spectral libraries, which are also in the dimensionless units of reflectance.  
Our spectral libraries, along with the corresponding geotechnical measurements taken 
at the same locations as the spectral data, form the basis of the spectral-geotechnical 
look-up table (LUT) that is the core of the method presented here. 

Once a reflectance cube has been obtained, the primary steps for producing the 
bearing strength estimate (based on the match between the hyperspectral imagery and 
our measured field spectral reflectance with its corresponding measurement of field 
dynamic deflection modulus) are: 

a) Load one or more of our NRL spectral libraries, or load the master 
library and select either all or the relevant subset of libraries to be 
used. 

b) Load the reflectance image to be processed 
c) Perform spectral matching 
d) Take the output of the spectral matching and run our routine which 

converts the mapped best spectral matches using the LUT which 
associates dynamic deflection modulus with the spectral library used 
in matching 
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e) If desired, re-bin the real-valued bearing strength output (dynamic 
deflection modulus in units of pressure), into categories (poor, fair, 
good, excellent) or some other set of ratings based on how these 
bearing strength estimates are to be interpreted in the context of the 
end-user’s application 

It should be noted that the model described in steps a)-e) can be applied to any 
measured geophysical parameter that has been associated with a particular spectrum.  
This report assumes that the geophysical parameter is the dynamic deflection 
modulus described above, but the same NRL HITT routines could be run equally well, 
employing spectral libraries linked through a LUT to other geo-technical parameters. 

4. Processing Steps 

4.1 Operation of Spectral Matching Software, match_spectra.pro 
Each of these steps is now described in greater detail.  Steps a)-c) are performed by 

our IDL routine match_spectra.pro, while step d) is carried out by 
build_spectral_geotechnical_lookup-table.pro (if a LUT is not already pre-assembled) 
and our IDL routine translate_from_lookup_table.pro.  Step e) is completed directly 
using already-existing routines within the ENVI/IDL environment.   

To begin, launch the ENVI/IDL environment.  From within windows, this will 
normally be either a menu item found in the start menu listing “ENVI+IDL 4.7” (or 
appropriate version number) or an equivalent shortcut on the desktop.  From within 
the Linux operating system, open a new shell, and type “idlde” at the command 
prompt.  This will start the IDL Development Environment (IDLDE).  From within 
IDLDE, at its command prompt, type “envi” to launch the ENVI interface.  In Linux, it 
is important to start ENVI in this manner rather than starting ENVI separately at a 
shell command prompt.  Starting ENVI from within IDLDE ensure that the two 
interfaces are “talking” to each other, which is necessary for our software tools to 
function correctly.  You can run into similar problems in windows if you start ENVI 
and IDL independently rather than using the menu item or desktop shortcut which 
starts both of them at the same time, so in Windows, always launch them with an 
option that activates ENVI and IDL simultaneously. 

Regardless of operating system, once ENVI and IDLDE interfaces are both up and 
running, go to the IDLDE interface, and select “Open File” from the “File” menu tab in 
the IDLDE interface.  Navigate to the NRL7232-HITT folder and select and open 
match_spectra.pro.  When loaded, a match_spectra.pro tab should be visible within 
the IDLDE as shown in Figure 2. 

Next compile the routine within IDLDE, by selecting the “Compile 
match_spectra.pro” option in the “Run” menu of IDLDE; this option becomes available 
once you have opened match_spectra.pro within the IDLDE.  After successful 
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compilation (acknowledged in the IDLDE console with a message “Compiled module: 
MATCH_SPECTRA”, return to the “Run” menu and select the now available “Run 
match_spectra” option.  This will begin the processing chain, which starts with a 
number of queries prompting the user to enter various information needed to run the 
program. 

After the program begins, two windows will appear (Figure 3).  One of these 
contains contact information about us, the NRL developers of this software.  This 
information window will need to be closed after the routine is completed (by clicking 
on the dismiss button labeled “x” in the upper right hand corner of the window) in 
order to return the focus of control to the window manager.  All of the other NRL HITT 
routines follow the same modus operandi in this regard.  The second window is an 
ordinary ENVI user file selection window, prompting the user to select an image to be 
classified by the match_spectra.pro routine.  Follow the usual methods to open a file 
with this interface, as outlined in the ENVI help manuals.  If the desired file has 
already been opened in ENVI, highlight it in this window with a button click on the 
name, and then click “OK.”  Otherwise, use the “Open” button and its associated 
options (“New File” or “Previously Opened Filed”) to load an image filename to the 
interface.  Figure 4 shows the popup file selection navigation window created when 
“New File” is selected.  In this example, the user selects the file 
“example_HSI_data.img”. Click “OK” and the image filename will be loaded into the 
main image selection window (Figure 4).  Highlight the desired image with a button 
click as shown in Figure 5 and click “OK”.  If the image was not previously loaded into 
ENVI/IDL, it will be at this point in the processing, and would be available in the ENVI 
“Available Bands List” for use after match_spectra.pro has finished processing. 
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Figure 2. After opening match_spectra.pro from the IDLDE file menu, you should see a tab with 
this IDL routine loaded in IDLDE. Compile the routine by selecting “Compile match_spectra.pro” 
option now available in the “Run” menu.  Then select the “Run match_spectra” option from the 
same menu when it becomes available after the compilation completes successfully. 
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Figure 3.  Windows that appear when match_spectra.pro is launched are (top) a contact 
information display about the NRL developers of this software suite and (bottom) the query 
interface requesting that the user select a hyperspectral image to process. 

Once the user has selected the hyperspectral image to be processed, the user is 
prompted to determine whether or not to apply a threshold to the matching algorithm 
results.  Figure 6 shows the radio-box style interface that appears giving the user the 
option to either accept or reject the idea of using a threshold with the matching scores 
between hyperspectral imagery (HSI) pixels and the closest matching spectral library 
element.  If the user selects the option to use a threshold, a second window will appear 
(Figure 6), prompting the user to enter the threshold value.  A default threshold value 
is provided, however, the user may wish to experiment with this parameter in order to 
determine which regions of the image would be excluded as the threshold is changed.  
The threshold value corresponds to a threshold on distance in spectral space between 
the closest matched spectrum and the spectrum of a given image pixel, where the 
comparison between these two spectra is the distance in spectral space.    
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Figure 4. Clicking on Open->New File from the image selection interface allows the user to 
navigate to an HSI data file if the desired data file has not already been opened in ENVI. 

Note that other matching algorithms could potentially be applied here, for example, 
ENVI’s “spectral angle mapper” (Kruse et al, 1993); however, the use of direct spectral 
distance, as is done in our match_spectra.pro software, may be preferred for a number 
of reasons.  One of the factors outlined by us in Bachmann, Nichols et al, 2010f, 2009, 
2008a, as being significant to the estimated retrieval of bearing strength is soil 
moisture, which directly affects overall albedo, as well as spectral shape.  Thus, the 
absolute value of the reflectance values, not just spectral shape, is actually relevant to 
the retrieval process.  Unfortunately, while spectral shape is preserved by SAM, it does 
not retain the overall power in the returned spectrum because it normalizes the 
spectrum to the unit hypersphere in the high-dimensional spectral space.  Thus, a 
spectral matching algorithm based on Euclidean distance in spectral space, as is done 
in match_spectra.pro, is preferred because it preserves the absolute reflectance levels 
in the hyperspectral data in the matching procedure.  However, one disadvantage of 
using Euclidean distance, is that it makes the matching procedure more vulnerable to 
errors in the hyperspectral data induced by imperfect calibration, atmospheric 
correction, or terrain-induced bi-directional reflectance distribution function (BRDF) 
effects.  SAM tends to be somewhat less vulnerable to these problems.  However, if the 
calibration is trusted and a robust atmospheric correction is undertaken, the benefit 
of a direct Euclidean match, which respects absolute reflectance values in the input 
spectra, is preferable.  We have provided match_spectra.pro in its present form for this 
reason. 
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Another reason for providing match_spectra.pro to end-users is that, although ENVI 
does provide a Euclidean distance matching procedure, it only operates on an image if 
the user has defined a set of associated ROI’s or ENVI vector files for the image to 
serve as the basis for defining the spectral library to match to the image.  That is, 
ENVI’s Euclidean matching algorithm currently cannot be applied directly to an 
imported spectral library in ENVI 4.7 without the user’s having written additional code 
in IDL.  Thus, we have provided match_spectra.pro for that purpose, and also to 
provide a means of rendering information about the outcome of the matching 
procedure, which, in our implementation, produces diagnostic products.   

 

Figure 5.  The example HSI data file is highlighted.  When the user clicks OK, this image will be 
designated as the file to be processed. 

These diagnostic products are intermediate products en route to our final product goal 
of an estimated bearing strength map, and can be used to both understand the results 
and modify the region of application of the spectral library and ultimately the spectral-
geotechnical LUT. 
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Figure 6. (Left) User interface querying whether the matching algorithm is to use a threshold to 
exclude regions of the image that are poorly matched to the spectral library.  (Right) If the user 
elects to use a threshold, this second popup window appears, prompting the user to enter a 
threshold. 

Once the user has either chosen to use a threshold or rejected this option, the user 
is then prompted to select a spectral library (Figure 7).  In the example in Figure 7, the 
user does not find the desired spectral library already open in ENVI, and therefore 
uses the “Open” menu to navigate to and select a spectral library called 
“field_spectral_data.sli” in directory “SpectralLibraries and Lookup Tables.” Once 
highlighted in the navigation pane, the user selects “Open” and returns the filename to 
the original spectral library query interface.  The user then highlights it again there (if 
it is not already highlighted), and clicks “OK.” 

Next the user is asked to select the first of two output product filenames (Figure 8).  
A query appears requesting the filename of the “Minimum Distance to Closest 
Spectrum” image product.  This output product is a diagnostic result that will show 
the user an image of the closest distance found to an element of the spectral library for 
each pixel in the original input HSI scene that the user selected at the outset.  Once 
the user has chosen the appropriate filename, the user is asked to define the filename 
for an image of the “Index of Closest Matching Spectrum.”  Basically, this output 
image product contains the index in the spectral library of the closest matching 
spectrum to each pixel in the input HSI scene.  Note that in this scene, an index of 0 
corresponds to the case where no match could be found within the prescribed set by 
the user, if the user opted to use a threshold as described above.  Otherwise the whole 
scene will be mapped, but the number of the spectral library elements will still start 
from 1, as the number 0 is reserved for the “no match” category, and this convention 
needs to be upheld for the stages of processing that follow.  In the example in Figure 8, 
the filenames “example_HSI_data_mindist_speclib_thresh0pt3.dat” and 
“example_HSI_data_minindex_speclib_thresh0pt3.dat” were chosen in the directory 
“L:\Example\Results.” 
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Figure 7.  (Top) Interface popup that appears asking the user to select a spectral library file. The 
“Open” menu can be used to open a new file if the desired library is not open already in ENVI.  
(Middle) Example migration by the user to a directory called “SpectralLibraries and LookupTables” 
where the user selects the library “field_spectral_data.sli” and clicks “Open.”  (Bottom)  The 
spectral library filename is then returned to the query interface where the user highlights it again, 
and selects “OK.” 
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Figure 8.  (Top) Filename query interface for the first of two output products: the user chooses a 
filename for an image diagnostic product that will display the distance of each HSI scene pixel to 
the closest matching element in the spectral library. This file, together with the threshold defined 
by the user (if the threshold option is selected), enables the user to interpret the effect of the 
threshold on which regions of the HSI scene would be excluded from a spectral match as the 
threshold is varied.  (Bottom) Filename query interface for the output product filename 
corresponding to an image of the closest matching index in the spectral library.  The index “0” 
corresponds to unlabeled regions (no match), while matched regions report the closest index in the 
spectral library with the numbering beginning sequentially from 1. 

At this point processing of the data begins.  Initially match_spectra.pro performs 
some preliminary processing steps to the spectral library before the matching is 
undertaken.  At first, the program will scan the spectra to make sure that there are no 
bad data, such as “Inf” or “NaN,” in any of the fields.  These can sometimes be 
observed in spectral library files where the processing of the reflectance data has 
become numerically unstable, usually around the large atmospheric absorption bands 
which produce often very small radiance values that become numerically unstable in 
the ratios that are taken to obtain reflectance.  These are usually omitted as “bad 
bands,” but match_spectra.pro makes sure that there are no residual problems.  If 
match_spectra.pro does find “Inf” or “NaN” entries in the spectral vectors of the library, 
it zeros these values out (replaces them with zeros) and copies the contents of the 
spectral library to a new spectral library in which the filename now has “_finite” 
inserted into the filename before the filename extension.  In the present example, 
match_spectra.pro finds such problems in the original library and copies the file 
“field_spectra_data.sli”, to a new library called “field_spectral_data_finite.sli.”  This 
library will be available in the ENVI interface after processing is complete as shown in 
Figure 9.   

After any non-numeric data problems are removed from the data, the spectral 
library is then resampled to the band centers and Full-Width-at-Half-Maximum 
(FWHM) of the HSI scene to be processed.  The resulting spectral library is also loaded 
into the available bands list in ENVI (Figure 9), and the tag label 
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“_spectrum_resampled_output” is added to the spectral library filename, so that in our 
example, the output spectral library filename is 
“field_spectral_data_finite_spectrum_resampled_output.sli”.  Note that in addition to 
being loaded into ENVI, in this example, both “field_spectral_data_finite.sli” and 
“field_spectral_data_finite_spectrum_resampled_output.sli” are saved automatically to 
disk in the same directory as the original spectral library file “field_spectra_data.sli.” 

Note also that when processing by match_spectra.pro has concluded, as shown in 
Figure 9, the two output product filenames selected by the user from the interface 
(Figure 8) are both listed (Figure 9) and these output image products have also been 
saved to disk in the user-specified location.   

 

Figure 9.  The ENVI Available Bands List appearance after match_spectra.pro has completed 
processing.  In this example, “NaN” and “Inf” values were detected in the original spectral file, 
“field_spectral_data.sli,” and eliminated.  The corrected spectral library file is saved to disk and 
loaded into ENVI as “field_spectral_data_finite.sli”.  This version of the spectral library is then 
resampled to the HSI scene specified by the user for processing.  The resampled spectral library, 
“field_spectral_data_finite_spectrum_resampled_output.sli,”  is also loaded into ENVI.  Finally, the 
two output products, “example_HSI_data_minindex_speclib_thresh0pt3.dat” and 
“example_HSI_data_mindist_speclib_thresh0pt3.dat” are also loaded into the ENVI Available Bands 
List when processing is completed. 
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4.2 Intermediate Output Products of match_spectra.pro 
Two output product images appear automatically when processing of the HSI scene 

with match_spectra.pro is complete.  These represent a set of intermediate products in 
our overall workflow leading to the final bearing strength product.  

 

Figure 10. Minimum distance to the closest spectral library element is displayed in the ENVI 
interface windows that automatically load at the conclusion of processing.  The default color map, 
loads this product into the Image, Scroll, and Zoom windows, as a grey-level image. 
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Figure 10 shows the first of these two intermediate products: a map of the 
minimum distance to the closest element found in the spectral library at each pixel in 
the input HSI scene.  This product will initially appear in the default color map, which 
renders this product as a grey-level image in ENVI (in the usual Image, Scroll, and 
Zoom displays that appear when a scene is loaded).  As with any image, this product 
can easily be re-rendered (Figure 11) in one of the many available color maps (Figure 
12) found in ENVI or the user can define his own color map in ENVI.   

 

Figure 11. The distance-to-closest-element-of-the-spectral-library image product rendered in the 
Blue/Green/Red/Yellow color map of Figure 12.  Since the spectra in the library in this example 
are land spectra primarily from beaches and marsh regions, note that the poorest spectral match 
as expected is over the water regions of the scene. 

 The second output product image that appears at the conclusion of processing by 
match_spectra.pro is a map of the index of the closest matching spectrum (Figure 13) 
found in the spectral library selected by the user using the interface components 
described in Figure 7.  In this example, since we are matching to spectra such as sand 
and other soil signatures in the spectral library, the ocean water in the image appears 
as category “0” or unlabeled data, resulting from a poor spectral matching score, 
which did not pass the rejection threshold set by the end user using the interface 
shown in Figure 6.  The user can understand the details of this result by selecting the 
“Cursor Location/Value” option from the “Tools” menu of the image display of the 



	
   16	
  

distance-to-closest-element-of-the-spectral-library image product in Figure 11, and 
then placing the cursor over various parts of the scene.  Figure 14 contrasts the 
residual error in the best spectral match to the spectral library for a pixel on the beach 
having a residual error of roughly 0.05 with that of one of the water pixels, having a 
residual error of about 1.3. 

 

Figure 12. Alternative color map used in the rendering of the distance-to-closest-library-spectrum 
image product in the example of Figure 11. 

 

Figure 14 also shows the ENVI “Cursor/Location Value Tool” when the cursor is 
placed over the second output product image of the closest matching spectral index.  
The Figure shows a region of good matching for a sand pixel, along with a poor 
matching over the water region which did not pass the user-entered matching 
threshold, and was associated, therefore, with the unlabeled category, with index 0: in 
the tool, the category name will read “Unclassified” when assigned to the rejected or 
unlabeled category and display the index 0 as the numerical value.   

The closest matching spectral index output product has an associated ENVI header 
file that defines the file type as “ENVI classification”, and the header is populated by 
match_spectra.pro with a default set of class or category names which are just the 
names of the spectral library elements.  It is these names, along with the spectrum 
index in the library, that appear when a particular pixel in this output product is 
highlighted. 
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Figure 13. Second output product of match_spectra.pro: a map of the index of the closest 
matching spectrum in the spectral library, rendered in the ENVI image, zoom, and scroll windows. 
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When match_spectra.pro has finished execution, the hyperspectral scene that was 
specified by the user as input can also be rendered in the usual way within ENVI/IDL.  
Figure 15 shows the input hyperspectral scene that was used to produce the products 
shown in Figures 10, 11, and 13. 

 

 

Figure 14. (Left) Cursor location/Value screens derived from the product in Figures 11 and 12, 
showing the residual error in matching the closest library spectrum to the scene spectrum at a 
particular pixel position.  The spectral-geotechnical library contains mainly beach and soil surface 
reflectance spectra and the corresponding bearing strength of the associated surface, so  (top, left) 
a close match is found for one of the beach pixels, while (bottom, left) a poor match is found in the 
water.  (Top, right) cursor location value screen showing the closest matching spectral library 
element of a beach pixel in Figure 13, for this case library element 65, with spectral name 
“pbj1a.rfl”, (bottom, right) for a rejected water region pixel that did not pass the threshold test set 
by the user. 

 

4.3 Translating the Spectral Match to Bearing Strength via the 
Look-up Table 

4.3.1 Motivation for the Spectral-Geotechnical Look-up Tables 
 The next steps involve translating the intermediate products produced by 
match_spectra.pro to a retrieved map product that estimates the corresponding 
bearing strength of the sand, soil, or sediment.  The correlations that exist between 
spectral reflectance and the geotechnical properties measured at the same location are 
the basis of this translation, and as described above, the method used here is a LUT 
approach (Bachmann, Nichols et al, 2010f, 2009, 2008a).  Some of the fundamental 
properties that determine bearing strength include, but are not limited to, moisture, 
grain size, and composition.  All of these influence the observed spectra in 
hyperspectral remote sensing.  Hyperspectral remote sensing obtains information only 
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about the surface properties of the earth, and cannot glean information about what is 
below the surface layer, except in a statistical manner.  There are, however, likely to  

 

Figure 15. Image, scroll, and zoom window showing the HSI scene used in this example.  When 
match_spectra.pro is finished processing, the scene can be loaded into a window for display, if it 
has not already been loaded into ENVI and rendered prior to starting the execution of 
match_spectra.pro. 

be natural relationships based on, for example, coast type and position relative to the 
shoreline that do exist, making such inferences possible.  Surface moisture level and 
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composition are relatively easy to retrieve from hyperspectral remote sensing; grain 
size is more difficult, but still feasible (Bachmann, Nichols et al, 2010f, 2009, 2008a), 
although explicit models that exist now for grain size do not presently cover all of the 
ranges of conditions that one might encounter.  Using a look-up table is a tacit 
acknowledgement that our modeling efforts are not comprehensive yet, and the table 
therefore takes the place of an explicit model in order to be able to address a broader 
range of conditions that might be encountered.   

Long term, we are investigating multi-sensor remote sensing modalities as a means 
of overcoming the limitations of hyperspectral remote sensing, which only records 
information from the surface.  Examples of complementary remote sensing modalities 
include the use of synthetic aperture radar (SAR) to estimate volumetric soil moisture 
(Dubois, van Zyl, and Engman, 1995), or thermal imagery acquired at different times 
to learn more about the thermal conductivity of layers beneath the surface.  For the 
time being, the use of a spectral-geotechnical look-up table approach to relating 
bearing strength and hyperspectral surface reflectance data is an excellent starting 
point.  Adding both improved models for hyperspectral information as well as 
additional information in the future from complementary remote sensing instruments 
will only improve accuracy and reliability of retrieved products.  

4.3.2 Nature of the Spectral-Geotechnical Look-up Tables 
In our previously published descriptions (Bachmann, Nichols et al, 2010f, 2009, 

2008a), we have outlined explicit models for retrievals of various quantities related to 
bearing strength such as soil moisture, grain size, and composition.  The look-up table 
approach described here and in (Bachmann, Nichols et al, 2010f, 2009, 2008a) does 
not attempt to retrieve these intermediate physical variables or use any of the explicit 
models for these variables that we have derived.  The LUT is a direct relationship table 
between measured bearing strength and spectral reflectance, although the LUT 
approach could certainly be applied to the retrieval of the intermediate physical 
variables as well. 
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Figure 16. Linking spectral reflectance to soil geotechnical parameters: (top row, left) Parramore 
island, VA, ASD spectrometer mounted on tripod to record spectral reflectance measurements; 
white reference Spectralon plaque also mounted on tripod; (top row, right) Zorn Light Weight Drop 
Tester (light weight deflectometer (LWD))  for recording bearing strength (dynamic deflection 
modulus). (Middle row) Waimanalo Bay, HI: (left) ASD spectrometer recording reflectance from 
backpack configuration; (right) view of the LWD and the data recording unit.  (Bottom row, middle) 
core sample used for grain size profiles and moisture analysis, flanked by (left) LWD with weight 
prepared for drop test, and (right) shear measurements with a dynamic cone penetrometer. 

Figure 16 shows examples of a typical measurement cycle in which ground 
measurements of spectral reflectance with an ASD spectrometer were complemented 
by bearing strength measurements with a lightweight deflectometer at the same 
location.  The look-up tables to be described provide a one-to-one association between 
the measured spectral reflectance of the surface and the bearing strength (dynamic 
deflection modulus) recorded by the lightweight deflectometer (LWD).  Although we 
record other geotechnical measurements such as shear strength (complementary to 
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the deflectometer measurements), soil moisture, and grain size distributions 
(Bachmann, Nichols et al, 2010f, 2009, 2008a; Bachmann, Nichols  et al, 2012d, 
2012e; Bachmann, Fusina, et al, 2012b; Bachmann, Fry, et al, 2012a), this document 
focuses on the look-up tables developed between the spectral reflectance and 
deflectometer measurements. 

4.3.3 Construction of Spectral-Geotechnical Look-up Tables Using 
build_spectral_geotechnical_look-up_table.pro 

Our NRL HITT convention is that spectral geotechnical look-up tables are simple 
ASCII files relating three quantities: a name identifying the spectrum, the associated 
spectral index (this is the integer class label that was assigned during classification 
either by the NRL HITT routine match_spectra.pro or by some equivalent matching 
already performed in the default ENVI/IDL package, for example using tools  such as 
Spectral Angle Mapper, and finally the associated geotechnical parameter associated 
with the spectrum as described in the previous section (Figure 17).  For the purposes 
of this report, we assume that the geotechnical parameter is the bearing strength 
described in the previous section, although this format could well be applied to other 
geotechnical parameters to be retrieved when appropriate libraries and geotechnical 
data are there to support such models. 
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Figure 17. Excerpt from the example spectral geotechnical look-up table file 
“spectral_geotechnical_lookup_table.txt” used later in this report. Column format is: (left) 
spectrum name or identifier, (middle) spectrum index in the library counting from 1 for the first 
spectral index, with 0 reserved for unlabeled data regions (here given the spectrum name 
“Unclassified” in keeping with ENVI software conventions, and (right) the retrieved geotechnical 
parameter associated with the spectrum, in our example the bearing strength recorded in MN/m2 

in field measurements by the LWD shown in Figure 16. 

 

We provide four different spectral-geotechnical look-up tables from our remote sensing 
campaigns and associated cal/val activities.  These four libraries are derived from field 

Unclassified 0 0
FWB-­‐B1A 1 4.432624113
FWA-­‐1A 2 8.516275549
FWB-­‐B2A 3 11.81102362
FWB-­‐B6A 4 14.09774436
FWA-­‐1E 5 16.37554585
FWA-­‐1B 6 16.98113208
FWB-­‐B3A 7 17.33436055
FWB-­‐B5A 8 17.94258373
FWA-­‐1D 9 18.04330393
FWA-­‐1F 10 18.48808546
FWB-­‐B4A 11 19.14893617
FWA-­‐1C 12 20.38043478
FWA-­‐3A 13 3.179313268
FWD-­‐02 14 3.652597403
FWD-­‐04 15 3.783420212
FWD-­‐03 16 5.184331797
FWD-­‐05 17 5.225267069
FWA-­‐3B 18 6.246529706
FWD-­‐01 19 6.853487664
FWD-­‐06 20 13.50540216
FWA-­‐3E 21 18.14516129
FWA-­‐3D 22 21.32701422
FWA-­‐3G 23 25.30933633
FWA-­‐3F 24 27.04326923
FWA-­‐3C 25 27.77777778
FWA5J 26 3.80131779
FWB-­‐5A 27 3.833702505
FWB-­‐5C 28 4.123144585
FWA5C 29 4.511730499
FWA5A 30 4.874350087
FWA5I 31 4.938542581
FWB-­‐5D 32 4.949406071
FWA5D 33 5.284170972
FWB-­‐5B 34 5.491823285
FWB-­‐5A 35 7.729302645
FWB-­‐5E 36 17.64705882
FWB-­‐5G 37 22.41035857
FWA5H 38 23.83474576
FWA5G 39 27.47252747
FWB-­‐5F 40 29.64426877
FWA5E 41 31.42458101
FWA5F 42 34.24657534
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measurements relating spectral reflectance directly to measured bearing strength 
determined from lightweight deflectometer measurements described in Section 4.3.2 
and portrayed in Figure 16.  In this NRL HITT release, version 1.0, we provide four 
spectral libraries and associated spectral-geotechnical look-up tables from the VCR’07, 
HI-HARES’09, TALISMAN SABER’09, and MI-HARES’10 campaigns (Bachmann, 
Nichols  et al, 2012d, 2012e; Bachmann, Fusina, et al, 2012b; Bachmann, Fry, et al, 
2012a)   outlined in the Introduction.  These can be used as is or can be used as the 
starting point for user defined look-up tables that are a subset or combination of one 
or more of these libraries and look-up tables, and/or subsets or combinations of 
libraries that the user has on hand.   Our spectral-geotechnical libraries are described 
in Section 5. In this section, we outline how to build the tables using the NRL HITT 
interface. 
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Figure 18. IDLDE interface after opening our IDL routine build_spectral_geotechnical_look-
up_table.pro. 

The IDL tool that we provide for this purpose, build_spectral_geotechnical_look-
up_table.pro, is a convenient interface for constructing these tables.  Although the 
user can elect not to use our tool and simply construct the table offline in a standard 
editor or in a spreadsheet program such as Excel that can export the result in the 
ASCII format of Figure 17, the advantage of using build_spectral_geotechnical_look-
up_table.pro is that it provides a direct interface into the spectral libraries already 
used within ENVI for the matching.  Our tool automatically loads associated spectral 
names and indices directly from the ENVI header information of our spectral libraries 
used during the matching procedure described earlier in this report.  The interface 
associated with our routine also allows the user to sub-select items from the spectral 
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table, or from a previously constructed spectral-geotechnical table.  It also permits 
rapid construction from spectral libraries and associated tables of geotechnical 
parameters that might be in separate files from field measurements. 

 

Figure 19.  Two windows which appear as execution of build_spectral_geotechnical_look-up_table 
begins: (left) interface query radio box for the user to determine the table construction mode, and 
(right) an information window about the software.  In this example, the user has selected the 
option of constructing a look-up table using a pre-existing table as a starting point. 

To begin, open build_spectral_geotechnical_look-up_table.pro in the IDLDE from the 
“Open file” option of the “File” menu (Figure 18) by navigating to this routine in the 
NRL7232_HITT folder.  As with our other NRL HITT routines described in other 
sections, compile the routine by selecting the “Compile 
build_spectral_geotechnical_look-up_table.pro” option in the “Run” menu of IDLDE; 
this option becomes available once you have opened the routine through IDLDE.    
After successful compilation, return to the “Run” menu and select the now available 
option “Run build_spectral_geotechnical_look-up_table.” 

At the beginning of execution, the program will bring up two windows shown in 
Figure 19: one is the usual information window about the software and the second is a 
radio box mode asking the user to select a “Table Construction Mode.”  There are two 
modes: “Construct from Pre-Existing Table” and “Construct New Table.”   

If the user selects “Construct from Pre-Existing Table,” as shown in Figure 19, an 
interface appears requesting the user to select the filename of the pre-existing look-up 
table to be used as the starting point for constructing a new look-up table.  Figure 20 
shows an example table file called “spectral_geotechnical_lookup_table.txt” selected by 
the user in the directory “SpectralLibraries and Lookup Tables.”  
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Figure 20.  Interface which appears to query the user to enter the pre-existing look-up table when 
the user selects the table construction mode “Construct from Pre-Existing Table,” as shown in 
Figure 19. 

 Once the “Open” button is pressed and the file is opened, a new interface appears 
(Figure 21) with a checklist of available look-up table entries for the user to choose 
from.  This interface widget allows the usual ENVI modes of either individually 
selecting items by clicking on them one at a time, or alternatively, the user can choose 
to add one or more ranges using the two input text boxes and the “Add Range” button 
immediately adjacent to these input text boxes.  If the user simply wants to retain all 
of the entries but give the file a different name or add additional entries, then this 
interface provides a third option, “Select All.”  If the user inadvertently selects entries 
not desired, then they can either be toggled off individually by clicking again on the 
entries in question or the user can select the “Clear” button to start over.   
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Figure 21.  Interface used for selecting look-up table elements to include from a pre-existing look-
up table.  Table entries in this interface are numbered in square brackets starting from one, 
however, note that the format of the actual entries is spectral name,  spectral index, and 
geotechnical value, with the spectral index starting from zero (the indexing scheme that would be 
in the output file).  This is a standard ENVI convention related to the indexing of classification 
products: the unclassified or unlabeled regions in a classification product have index zero, which is 
the convention we use for match_spectra.pro. 

Once entries to be used from the pre-existing table have been finalized by clicking 
the “OK” button shown in Figure 21, another interface appears asking the user to 
enter an initial filename (Figure 22) in which to store these entries (the user will 
subsequently be given the opportunity to edit or add more entries).   The IDL console 
will also produce feedback indicating which items in the list were selected and the 
table of results will be printed to the console: 

Selected Items           2           5           6          20          21          22          25 
Wrote the following items to new look-up table filename L:\Example\SpectralLibraries and 
Lookup Tables\my-new-spectral-geotechnical-lut.txt: 
 FWA-1A 2 8.516275549  
 FWA-1E 5 16.37554585  
 FWA-1B 6 16.98113208  
 FWD-06 20 13.50540216  
 FWA-3E 21 18.14516129  
 FWA-3D 22 21.32701422  
 FWA-3C 25 27.77777778 

To proceed to the next interface window, click the “Open” button shown in Figure 22 
once a filename and directory have been determined. 

The subsequent interface that pops up (Figure 23) is an editor window that opens 
an intermediate version of the new look-up table with the entries just selected by the 
user from the pre-existing table.  This window permits the user to make any final 
adjustments by directly editing the new look-up table file.  For example, the user can 
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manually type new entries, delete any undesired entries, or paste in selections from 
another table in a different file.  If any edits are applied, they must be saved by 
clicking the “Save” button on the interface.  The user can also opt to save any version 
of the changes under a different name with the “Save As” button.  When done, the 
user clicks on the button “Done with ….” in order to close the file. Note that this only 
closes the current state of the file since the last save operation; pressing “Done with…” 
does not save any changes to the file that have occurred between the last time  the 
“Save” button has been pressed and the moment when the “Done with…” button is 
pressed. 

 

Figure 22. Interface prompting the user to select a filename in which to store the new look-up 
table.  In this example, the user chooses a file named “my-new-spectral-geotechnical-lut.txt” to be 
stored in the directory “SpectralLibraries and Lookup Tables.”  The user will be given a final 
opportunity to edit this file in a subsequent interface that appears immediately after the filename 
is selected and the user presses the “Open” button here. 
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Figure 23. Editor interface that appears to allow the user a final chance to add, delete, or edit 
entries as needed.  New entries can be typed in or pasted in from other files.  Use the “Save” 
button to keep any intermediate or final changes or “Save As” to save intermediate or final results 
to a different filename.  The “Done with…” button only closes the previously selected output 
filename; it does not save results: this can only be done with the “Save” and “Save As” buttons. 

Once the “Done with…” button is pressed on the interface shown in Figure 23, the 
look-up table construction step is complete. 

 

Figure 24. Table Construction Mode radio-box dialog with the “Construct New Table” selected. 

Returning to the “Table Construction Mode” interface, we will now examine other 
pathways that can be followed to define a new spectral-geotechnical look-up table. If 
the user decides to select the option “Construct New Table,” a series of options is then 
presented to the user to construct the table from scratch.  Upon clicking the “OK” 
button in the “Table Construction Mode” radio-box dialog shown in Figure 24, an 
interface appears prompting the user to enter the name of a spectral library to be used 
in constructing the new look-up table (Figure 25).  In the example shown in Figure 25, 
the user selects the spectral library file 
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“file_spectral_data_finite_spectrum_resampled_output.sli,” which was the resampled 
spectral file produced by match_spectra.pro in our earlier example.  Select the 
spectrum filename and click “OK.”  A new radio-box dialog will appear asking the user 
to specify whether or not there is a file with a list of geotechnical values already in 
one-to-one correspondence with the spectral file selected.  Figure 26 shows this query 
in an example where the user has selected the option “Yes.” 

If the user has selected “Yes” in response to the query about the existence of a 
geotechnical value list, then, upon pressing the “OK” button, a new interface dialog 
box will appear asking the user to select the name of the file holding the geotechnical 
list values (Figure 27).  In Figure 27, the example shows that the user has selected a 
file called “geotechnical_table.txt” in directory “SpectralLibraries and Lookup Tables.”   

 

Figure 25. Dialog that appears to prompt the user to enter the name of a spectral library file to be 
used in constructing a new look-up table. 

At this point, the routine will merge the geotechnical values from the geotechnical 
list file that are in one-to-one correspondence with the spectral library samples (from 
field measurements) and their spectral names parsed from the ENVI header of the 
spectral library file, and add a spectral index consistent with the ENVI conventions 
described above for match_spectra.pro and standard ENVI matching routines.  As 
before, the layout of the new merged result is a table with three columns for spectral 
name, spectral index, and corresponding geotechnical value.  The interface with the 
newly merged table is shown in Figure 28.  Note that our NRL HITT routine will also 
add an entry for unlabeled or unclassified data in the scene.  As described above, this 
follows the ENVI convention that this category, which corresponds to unlabeled parts 
of the scene not classified by the spectral matching routine, must have spectral index 
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0 in the classification result, and have spectral name “Unclassified.”  We assume that 
since these regions have no data, that the appropriate geotechnical value to associate 
with this unlabeled category is a value of 0.0 (the user can edit this value later if a 
different convention is to be followed).  At this point the user must select entries to 
include in the look-up table through the interface shown in Figure 28, and as before 
the user can toggle on or off individual look-up table entries, add ranges using the 
“Add Ranges” button and the associated text entry fields for entering the numerical list 
element range values, select all elements at once using the “Select All” button, or clear 
selections using the “Clear” button. 

 

Figure 26.  Interface query asking the user to specify whether there is already an existing file 
containing a list of geotechnical values in one-to-one correspondence with the selected spectral 
library file. 

After the look-up table entries are accepted by pressing the “OK” button, a dialog 
interface window appears querying the user to enter a filename for the file in which the 
resulting table is to be stored (Figure 29).  Once selected and accepted with the “OK” 
button,  the resulting table currently stored in the new file is displayed in an edit 
window (Figure 30).  This window allows the user to make any final revisions, by 
editing specific entries, deleting any unwanted entries, pasting in entries from another 
file, or manually typing in new entries.  When finalized, the user selects the “Done 
with…” button to close the file.  Note that the “Done with…” button does not save 
results; it only closes the file from the edit window.  To save final or intermediate 
results, the user must use either the “Save” or “Save As” buttons which function in the 
customary manner. 
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Figure 27. User interface querying for the filename of the pre-existing geotechnical data file. 

There is one final optional method of constructing a new look-up table from scratch.  
The interface window in Figure 26 is the branch point.  If no pre-existing geotechnical 
table exists where the geotechnical values are already in one-to-one correspondence 
with the spectral library, then our NRL HITT routine assumes that the geotechnical 
values are to be entered through the interface.  This alternate pathway to constructing 
a look-up table is explored by selecting the “No” option in this interface as shown in 
Figure 31.  Doing this and clicking the “OK” button, will then bring up a selection 
window, in which the user is asked only to select which spectra are to appear in the 
table (Figure 32).  This selection window interface follows the same model of allowing 
the user to toggle on or off individual spectra, add ranges, select all, or clear selections 
as needed.  When a list of spectra has been selected, the user clicks the “OK” button. 
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Figure 28.  Merged look-up table entries appear in a dialog, where the user can select any subset of 
these entries for the new table. 

At this point, the routine will launch a table with the spectral names just picked, their 
corresponding spectral index, and a placeholder column for the geotechnical values to 
be entered for each spectrum name.  As before and by ENVI convention, the unlabeled 
category is called the “Unclassified” category and has spectral index 0.  The default 
appearance of the table is shown in Figure 33 for the spectra selected in the example 
shown in Figure 32. 
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Figure 29.  Dialog for selecting the output filename of the new look-up table file.  Here the user 
selects a file named “second_new_spectral_geotechnical_lut.txt” in directory “SpectralLibraries 
and Lookup Tables.” 

The table that appears in Figure 33 has three columns with the spectral names just 
selected, the corresponding spectral index, and finally a placeholder for the 
geotechnical values to be entered.  Any of the fields is editable, however, the normal 
use of this table interface is to enter the geotechnical values by either selecting and 
typing them in or by pasting them in from some other file.  Note that in selecting a 
field and entering the new value by typing or pasting, the user must hit the “Enter” 
key on the keyboard for each value entered in a given field.  If the user fails to hit the 
“Enter” key on the computer keyboard after entering a value in a table cell, it will not 
be captured by the program.  Therefore, the user must remember to hit “Enter” after 
each value is typed or pasted into a cell in the table.  One other point to note is that 
the table entries in this interface currently only support seven digits to the right of the 
decimal place.  This is not an important limitation for the present application, which 
does not require that level of precision, or for many applications for that matter.  
Entering additional decimal places will just result in the number being rounded when 
the “Enter” key is pressed on the keyboard.   

Once finalized, the user selects the “Save” button on the table, and a second dialog  
(Figure 34) will appear, requesting that the user enter the filename into which the 
current state of the table should be saved.  After entering the filename, the user 
selects the “OK” button to save the table.  The table can be dismissed either by hitting 
the “Quit” button, or by clicking on the “x” in the upper right hand corner. 
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Figure 30. Edit window for the selected entries for the new merged look-up table.  As before, 
entries can be edited or deleted, and new entries can be typed in manually, or pasted in from 
another file.  “Save” and  “Save As…” operate in the customary manner; “Done with …” button 
only closes file; saving must be done with “Save” or “Save As…” 

 

Figure 31. Option “No” selected when a geotechnical list in one-to-one correspondence with the 
spectral library has not already been created.   This leads to a different chain of interfaces that 
ultimately allows the user to construct this information by entering the values directly. 
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Figure 32.  Spectra are selected by the user to be included in the look-up table through this 
interface. 

 

Figure 33.  Table widget for entering geotechnical values corresponding to the spectral library 
name elements.  The layout of the column is: spectral name, spectral index, geotechnical value.  
All fields are editable, although the primary reason for this interface is to enter geotechnical 
values. After selecting a cell in the table and either typing in or pasting a value, the user must hit 
the “Enter” button on the keyboard in order for the change to be entered permanently in the table.  
To save results, the user must press the “Save” button. 

 

Figure 34. Hitting the “Save” button brings up a standard dialog window for choosing the output 
filename of the look-up table. 
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Figure 35.  The IDL interface after loading the third processing routine 
translate_from_lookup_table.pro. 

 

4.3.4 Spectral-Geotechnical Look-up Table Specifics: Operation of 
translate_from_lookup_table.pro and Example Results 

To begin the translation process from the intermediate output products of the 
spectral matching procedure, match_spectra.pro, the user will need to load the IDL 
routine translate_from_lookup_table.pro into the IDL interface by going to the “File” 
menu, and selecting the “open file” option.  The user will navigate to the 
NRL7232_HITT folder and open this IDL program.  When completed the IDL interface 
should look like the screen capture shown in Figure 35.  
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Once the program is loaded, the user will select the now available option, “Compile 
translate_from_lookup_table.pro” in the IDLDE “Run” menu.  The user then returns to 
the “Run” menu and selects “Run translate_from_lookup_table.”  At the beginning of 
program execution, two interface windows (Figure 36) appear, one an information 
window with a brief description of the software and the second window, which queries 
the user to select the previously labeled scene to be translated by the spectral-
geotechnical look-up table.  As before, the user employs this interface to navigate to 
the output product scene provided by match_spectra.pro earlier, in this case the image 
of closest matching spectral indices produced by match_spectra.pro and shown in 
Figure 13. 

Once the spectral index image has been selected for translation.  The look-up table 
must then be loaded.  At this point, a second query window will appear (Figure 37) 
asking the user to select an appropriate look-up table file.  In the example of Figure 
37, the file selected by the user is “spectral_geotechnical_lookup_table.txt” in the 
folder named “Spectral Libraries and Lookup Tables.” 

As shown earlier in Figure 17, the expected format of the spectral geotechnical look-
up table file is an ASCII file with three columns, where the first column is the category 
label (usually the spectrum name or identifier), the index of the spectrum in the 
spectral library, where the count starts from index 1, and the index 0 is reserved for 
unlabelled data (by ENVI convention called the “Unclassified” category where no match 
is found), and the third quantity is the associated geotechnical value, in our case, the 
estimated bearing strength (dynamic deflection modulus) from the LWD.  An example 
of this type of file is shown in the excerpt in Figure 17, which depicts the first 45 
entries in our example look-up table file spectral_geotechnical_lookup_table.txt. 

After the spectral geotechnical lookup table is loaded, a third interface window 
appears, querying the user to enter an output filename for the final retrieved product.  
This is shown in Figure 38, where we have selected the output filename 
“example_HSI_minindex_speclib_thresh0pt3_retrieval.img.”  Once  this query is 
answered by the user when the user selects “OK” in the interface shown in Figure 38, 
processing begins.  When the retrieval is complete, it is automatically rendered in 
ENVI as shown in Figure 39.  The result will initially be displayed as a grey scale 
image in a new ENVI image/scroll/zoom set of windows.  However, the user can easily 
re-render the results in one of the available ENVI colormaps as shown in Figure 40. 
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Figure 36. Windows that appear when translate_from_lookup_table.pro is started are (top) a contact 
information display about the NRL developer of this software module, and (bottom) the query 
interface requesting that the user select a previously labeled scene (one run by match_spectra.pro 
or a similar routine that has produced an ENVI classification image in which the image values 
represent the indices of the elements of the spectral library to be linked now with the associated 
geotechnical measurements in the current stage of processing).  Shown here: the user selects the 
output product from the previously described run of match_spectra.pro:  
example_HSI_data_minidex_speclib_thresh0pt3.dat. 
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Note that the displays in Figure 39 and 40, which show the retrieved map of 
estimated bearing strength, also show a data legend, describing how the displayed 
color relates to estimated bearing strength.  To superimpose this data legend, the user 
can select the “Annotation” option on the “Overlay” menu of the image window in 
which the retrieved bearing strength is displayed.  This will bring up the ENVI 
annotation interface.  On the annotation interface window, the user selects the “Color 
Ramp” option on the “Object” menu and then positions the cursor at the location on 
the image display where the legend is to be positioned and clicks with the left mouse 
button.  After editing display features of the legend such as minimum and maximum 
for the given image stretch, character fonts, etc., the user clicks on the display with 
the right mouse button to finalize the legend.  This will place the color ramp and 
numerical equivalents along the axis below the color ramp.  After that, the annotation 
tool “Object” menu “Text” option can be used to place additional text such as the units 
of MN/m2 or the “+” symbol that appear in the displayed legends of Figures 39 and 40.  
Note that if the user decides to export the ENVI display of the retrieved image product 
to a standard graphics file format such as TIFF, PNG, JPEG, etc., the legend will 
appear in the exported graphics file. 

 

Figure 38.  Interface popup window, querying the user to enter a filename for the output product 
of translate_from_lookup_table.pro.  

Figure	
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4.3.5 Binning the Resulting Retrieval to Satisfy User Needs 
As we have shown, the available color maps in ENVI can be used to re-render the 

output product map, in our case, an estimated map of bearing strength.  As before, 
the cursor location value tool can be used to query the retrieved value of individual 
pixels.  However, the user may wish to categorize the data based on the user’s 
particular application.  One way to accomplish is to bin the data within ENVI. 

In order to bin the retrieved output product, the ENVI density slice tool can be used 
to section the bearing strength retrieval into distinct bands.  To achieve this, the user 
goes to the “Tools” menu on the ENVI image window in which the retrieved product is 
displayed and navigates down two levels of sub-menus to menu item Tools->Color 
Mapping->Density Slice.  Select the product to be binned (Figure 41) and click “OK.”  A 
default range of proposed bins is provided automatically, and displayed in an ENVI 
“Density Slice” interface (Figure 41), and the image display window of the retrieved 
product now, at least temporarily uses this default set of bins to render the retrieved 
product.  Through the Density Slice ENVI interface, the user can either chose to edit 
these bins by changing the number of bins, the bin ranges individually, or 
alternatively, the user can elect to re-load a previously constructed set of bins saved in 
a previous session by going to the “File” menu on the Density Slice, and selecting the 
menu option “Restore Ranges.”   Note that after editing the default ranges, restoring a 
set of previously saved ranges, or some combination of these two steps, the resulting 
bins are applied to the retrieved product by clicking on the “Apply” button on the ENVI 
Density Slice interface.  If the user makes any changes to a set of bin ranges, these 
changes to the bins can be saved for future use by selecting the “Save Ranges” menu 
option on the “File” menu of the Density Slice ENVI interface. 
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Figure 39.  Output product of translate_from_lookup_table.pro, using the ENVI default grey-scale 
color-map: the estimated bearing strength in MN/m2 is rendered in the standard ENVI image, 
scroll, and zoom windows once processing by translate_from_lookup_table.pro completes. 
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In our example, we have divided the resulting retrieved product into somewhat 
arbitrary ranges based on the retrieved bearing strength estimate, which is in units of 
MN/m2.  We have labeled our categories “Bad”, “Poor”, “Fair”, “Good”, and “Excellent.”  
In this example, the ranges for the five categories are depicted in Table 1.  Obviously, 
the specific manner in which the data is to be binned will depend on the user’s 
application.   

Table 1.  
 
 
 
Bearing Strength Conditions 
Example Categories 

LWD 
Measured 
Dynamic 
Deflection 
Modulus 
in MN/m2 

  
Excellent 

28.3 or 
greater 

Good 21.6 – 28.3 
Fair 14.9 – 21.6 
Poor  8.2 – 14.9 
Bad 0 - 8.2 

 

Once a binning of the data has been selected, one can apply a key to the resulting 
product by using the annotation tool in ENVI.  To achieve this, the user selects the 
“Annotation” menu item from the “Overlay” menu on the product ENVI Image display.  
This will bring up the ENVI Annotation interface.  From the “Object” menu of the ENVI 
Annotation interface, select “Map Key”.  The interface will change to reveal an “Edit 
Map Key Items” button (Figure 42).  Selecting this button will bring up a second 
interface which allows the user to edit the individual map key items changing the text 
and color code associated with each entry (Figure 42).  In the example of Figure 42, we 
edited the map key items to correspond to the ranges and colors defined in the density 
slice interface shown in Figure 41.  As with the color legend examples described above 
and displayed in Figures 41 and 42, the user superimposes the map key items 
corresponding to the density slice bins by clicking on the image display window with 
the left mouse button.  When the position of the map key is satisfactory, the user 
finalizes it with a right mouse button click on the image display. 

Figure 43 shows a subset of the resulting binned bearing strength retrieval using the 
bin ranges defined in Table 1 and implemented through the interfaces in Figure 41 
with the bin legend being specified through the interface described in Figure 42.  The 
retrieved bearing strength map data can be re-binned depending on the end-user’s 
applications or needs. 
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Figure 40. Re-rendered version of the output product of translate_from_lookup_table.pro, using the 
ENVI rainbow color-map: the estimated bearing strength in MN/m2 is rendered in the standard 
ENVI image, scroll, and zoom windows once processing by translate_from_lookup_table.pro 
completes. 

. 
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Figure 41.  (Top) ENVI density slice selection window with the available retrieved output product 
produced by translate_from_lookup_table.pro.  The user selects this to bring up the ENVI density 
slice tool, which allows the user to bin the data and assign a color table to the defined bin ranges.  
(Bottom, left) A default set of bins produced by ENVI automatically; (bottom, right) the final bins 
edited in this interface to correspond to the bin ranges defined in Table 1. 

5. Spectral Geotechnical Libraries 
A master composite spectral library of sand, soil, and sediment reflectance spectra 
from the four campaigns (VCR’07, HI-HARES’09, TALISMAN SABER’09, and MI-
HARES’10) appears in the directory with filename 
nrl7232_hitt_master_substrates_spectral_library_4campaigns.sli.  Individual libraries 
for each campaign appear in separate libraries entitled: (i) 
nrl7232_hitt_vcr07_substrates_spectral_library.sli, (ii) 
nrl7232_hitt_hihares09_substrates_spectral_library.sli, (iii) 
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nrl7232_hitt_queensland_australia_2009_substrates_spectral_library.sli, and (iv) 
nrl7232_hitt_mariana_islands_2010_substrates_spectral_library.sli.  The spectral 
libraries were collected during field measurements which coordinated both spectral 
and geotechnical measurements at each location as documented in Section 4.3.2 and 
portrayed in Figure 16.  The libraries are all in ENVI spectral library format and all 
come with an associated ENVI standard header, which has the same filename with a 
“.hdr” file extension.  Each library has the typical information expected in an ENVI 
spectral library header, such as wavelength grid, full width at half maximum (FWHM), 
as well as spectral names associated with the various spectral samples.  Each spectral 
sample is fully documented in the data reports (Bachmann, Nichols  et al, 2012d, 
2012e; Bachmann, Fusina, et al, 2012b; Bachmann, Fry, et al, 2012a) associated with 
each campaign as each field sample position had a unique position identifier 
associated with it.  This identifier name is common to both spectral and geotechnical 
measurements described in these reports, and these reports also provide site photos 
and GPS position data to help end-users understand the context of these spectral and 
geotechnical measurements.  All of our data, field measurements as well as imagery 
and products, appear in project geodatabases (Bachmann, Nichols  et al, 2012d, 
2012e; Bachmann, Fusina, et al, 2012b; Bachmann, Fry, et al, 2012a) which are also 
available to end-users upon request.  Figure 44 shows a set of typical spectral samples 
derived from our HITT spectral-geotechnical libraries.  As described in Section 4.3.2, 
these spectral geotechnical look-up tables can be used as is or as the starting point for 
building new libraries incorporating additional data that end-users might wish to add. 
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Figure 42.  (Top) ENVI annotation interface after “Map Key” option selected from the “Object” 
menu. (Bottom, left) Default ENVI map key definitions interface that appears when “Edit Map Key 
Items” is selected on the ENVI annotation interface.  (Bottom, right)  The final state of the map 
key items, corresponding to the density slice ranges of Figure 41, after editing each entry through 
the interface. 
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Figure 43.  Binned version of bearing strength map retrieval product, using the bins defined in 
Table 1 and implemented through the interface shown in Figure 41.  The bins legend was 
superimposed using the interface shown in Figure 42. 
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Figure 44.  Example spectral reflectance data from NRL HITT spectral-geotechnical libraries 

6. Applications Guidance 
Coastal characterization is the long term goal of NRL efforts.  To develop robust 

map products that support environmental understanding in coastal environments, 
models and methods must be developed for representative coastal types.  The NRL 
HITT software tool described in this report is one of several such thrusts being 
undertaken by NRL to develop and validate products for coastal characterization.  In 
addition, to the trafficability maps made possible by retrieved bearing strength 
estimates (Bachmann, Nichols, et al, 2010f) from NRL HITT, we have also been 
involved for a number of years in efforts to develop other coastal products from 
hyperspectral imagery such as shallow water bathymetry (Bachmann, Montes, et al, 
2010; Bachmann, Ainsworth et al, 2009), detailed land-cover mapping (Bachmann, 
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Bettenhausen et al, 2003; Bachmann, Nichols, et al, 2010g), vegetation density 
(Bachmann, Ramsey, et al, 2007), as well as waterlines (Bachmann, Nichols, et al,  
2007).  We have also worked on the development of methods for detecting scene 
hazards and anomalies (Bachmann, Ainsworth, Fusina, 2010; Bachmann, Fry, et al, 
2012a).   

The NRL HITT tool is a model for how we develop and validate software, and the 
future development of tools by Code 7232 will follow this same approach, which is 
based on providing new exploitation tools as add-ons to existing commercial software, 
such as ENVI/IDL.  By adopting existing commercial frameworks, transition to DOD 
end-users is facilitated.  We believe that natural transition points for NRL HITT would 
be the Marine Corps Topographic Production Capability (TPC).  Potential end-users 
who do not have TPC could still use NRL HITT specifically because it has been written 
as an add-on to the commercial package ENVI/IDL.   

Like all of the tools that we have been developing, the NRL HITT will be updated as 
we undertake new remote sensing and cal/val campaigns in other coastal venues, and 
especially in other coastal types.  Improved methods and libraries, for example, that 
exploit the angular dependence of spectral reflectance using our new capital 
equipment acquisition, the NRL Goniometer for Outdoor Portable Hyperspectral Earth 
Reflectance (GOPHER) (Figure 45), will also be fielded as they are validated.  Coastal 
characterization is a key factor in all littoral planning, and the NRL HITT is an 
important piece of NRL’s overall vision for providing important tools to support 
characterization of the coastal environment. 
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Figure 45.  The NRL Goniometer for Outdoor Portable Hyperspectral Earth Reflectance (GOPHER) 
was acquired under a capital equipment purchase in July 2010.  Developed by SpectraVista, 
University of Lethbridge, and the University of Saskatchewan, this goniometer is capable of 
characterizing the bi-directional reflectance distribution function (BRDF) which characterizes 
hyperspectral reflectance over a full hemisphere with a portable full-range (visible, near infra-red, 
and short-wave infra-red) HR-1024 spectrometer.  BRDF can vary dramatically with sun-target-
sensor geometry, and multi-angular studies will allow improvements in the extraction of important 
environmental parameters. 
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